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Notices
© Agilent Technologies, Inc. 2011

No part of this manual may be reproduced in 
any form or by any means (including elec-
tronic storage and retrieval or translation 
into a foreign language) without prior agree-
ment and written consent from Agilent 
Technologies, Inc. as governed by United 
States and international copyright laws.

Manual Part Number
G1431-90002

Edition
First edition, March 2011

Printed in USA

Agilent Technologies, Inc.
5301 Stevens Creek Boulevard 
Santa Clara, CA 95051 USA

Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connec-
tion with the furnishing, use, or per-
formance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in accor-
dance with the terms of such license.

Restricted Rights Legend
U.S. Government Restricted Rights.  Soft-
ware and technical data rights granted to 
the federal government include only those 
rights customarily provided to end user cus-
tomers.  Agilent provides this customary 
commercial license in Software and
technical data pursuant to FAR 12.211 
(Technical Data) and 12.212 (Computer Soft-

ware) and, for the Department of Defense, 
DFARS 252.227-7015 (Technical Data -Com-
mercial Items) and DFARS 227.7202-3 
(Rights in Commercial Computer Software 
or Computer Software Documentation).

Safety Notices

CAUTION

A CAUTION notice denotes a 
hazard. It calls attention to an oper-
ating procedure, practice, or the 
like that, if not correctly performed 
or adhered to, could result in 
damage to the product or loss of 
important data. Do not proceed 
beyond a CAUTION notice until the 
indicated conditions are fully 
understood and met. 

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly per-
formed or adhered to, could result 
in personal injury or death. Do not 
proceed beyond a WARNING 
notice until the indicated condi-
tions are fully understood and 
met.
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1 Introduction

In This Book

This document contains an overview of the items included with 
your system. It is intended to help you get started using your 
GC/Ion Trap System. 

In the following pages you will find: 

• Details on where to find additional help

• Photos of your hardware 

• Each toolbar found in the MS Workstation software

• Procedures for common MS Workstation operations

• A brief section on basic troubleshooting

• A summarized maintenance schedule

Please refer to your online help and the electronic manuals and 
videos included on your supplied disk for detailed information. 
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Where to Find Help

User Information DVDs

Your system comes with an extensive library of reference 
material including online help files, electronic manuals, and 
videos delivered to you on separate DVDs that are supplied with 
each instrument.       

The Agilent Technologies GC & GC/MS Hardware User Information and 
Utilities DVDs are included with each instrument, and provide 
in-depth reference and maintenance material for curent Agilent 
gas chromatograms, mass selective detectors, ion traps, and GC 
samplers.

These DVDs include localized versions of the information you 
need most, such as: 

• Getting Familiar documentation

• Safety and Regulatory guides

• Site Preparation checklists

• Installation information

• Operating guides

• Maintenance information

• Troubleshooting details
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1 Introduction

Online Help (F1)

For each installed instrument, the associated online help files 
include detailed MS Workstation instructions on topics such as: 
• What’s New?
• Diagnostics
• Startup and Shutdown procedures
• Running an Analyses 
• Setting MS Operation Parameters

To access the online help, press F1, or select Help topics from the 
Help menu.

Indicates a single help 
topic. To open the topic 
click it.

Help icons

Indicates a book 
containing more help 
topics. To open a book, 
double-click it.

Indicates an open book of 
help topics. To close an 
open book, double-click 

Functions
Hide/Show Lets you turn on or off 

the display of the list of help topics.
Back Goes back to the previous help topic.
Print Lets you print the current book or help topic.
Contents Displays the list of help topics (shown above).
Search Lets you type a word or phrase and then displays a list of all the topics in the online help that contain 

those words.
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To print a single help topic 

1  Highlight the topic you want to print (for example, Configuring 
the display).

2  Right-mouse click, and select Print… 

3  Select Print the selected topic and click OK.

4  Verify the printer selected and click Print.

5  The information on that single topic will print. The topics 
linked to it will not print.

To print all subtopics in a heading at once 

1  Highlight the topic you want to print (for example, Configuring 
the display).

2  Right-mouse click, and select Print… 

3  Select Print the selected heading and all subtopics, and click OK.

4  Verify the printer selected, and click Print.

5  The information for ALL topics within the heading of the 
selected topic will print. In this case, all topics under the 
book named Manual Control Tab would print, which is about 8 
pages of information.
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1 Introduction

What’s New in This Revision

MS Workstation now provides support for the Agilent 7890A GC 
and 7693A ALS instruments and Windows 7.
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Hardware

The Agilent 240 Ion Trap MS with an Agilent 7890 GC and 7693 
Automatic Sampler
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1 Introduction

Keypad for the 7890 GC

The MS Workstation software provides instrument control for 
the 7890 GC. This allows you to use the software, instead of the 
GC keypad, to program the instrument. However, there are 
times when you may want to use the keypad to quickly access 
some functions.

The Run Keys

GC Component Keys

General Data Entry Keys

Method Storage and 
Automation Keys

Supporting Keys
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Safety Warnings

WARNING Do not perform maintenance with the Ion Trap on or connected to its 
power source unless specifically instructed to by documentation 
supplied with the Ion Trap.

The Ion Trap interface can be on and at a dangerously high 
temperature even though the Ion Trap is off. After it is turned off, the 
Ion Trap interface cools very slowly. Make sure all parts have cooled 
before handling them.

Be careful when working behind the GC. During cool-down cycles, 
the GC will emit hot exhaust that could cause burns.

If you are analyzing toxic chemicals or using toxic solvents, use a 
hose to route the pump exhaust out of your laboratory. Note that the 
oil trap provided with standard foreline pumps stops foreline pump 
oil only, it does not trap or filter out toxic chemicals.

Use chemical-resistant gloves and safety glasses when replacing 
pump fluid. Avoid all contact with the fluid.

The insulation around the inlets, detectors, valve box, and insulation 
cups is made of refractory ceramic fibers (RCF). Avoid inhalation of 
RCF particles. Ventilate your work area, wear long sleeves, gloves, 
safety glasses, and a disposable respirator. Dispose of insulation in a 
sealed plastic bag. Wash your hands with soap and cold water after 
handling RCFs.
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2 MS Workstation Views and Toolbars

MS Workstation Startup Icon

At installation, the Workstation Toolbar shortcut is placed on the 
Desktop. Click the icon to display the MS Workstation toolbar. 

MS Workstation Main Toolbar

The main MS Workstation toolbar provides:

• Application buttons (items 1 through12 below) and 

• Quick Link buttons (items 13 and 14 below).

Rest the cursor on any Application button to show: 

• The application name, as a tooltip directly under the button.

• A brief description of the application, to the right of the 
button.

Right click an Application button to display a menu from which 
you may either get help for that item, or run the application.

Click a Quick Link button, similar to items 13 and 14 below, to 
display a menu of tasks that may be performed on the listed file.

 1 2 3 4 5 6 7 8 9 11 12 13 1410

1 
System Control/Automation
Monitors instrument status, performs automated injections, and batch 
recalculations.

2
View/Edit Methods
Lets you view and edit instrument operation, data acquisition, and 
data handling methods.

3
Edit Automation Files
Lets you edit SampleLists, RecalcLists and Sequences off-line.
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4
Review/Process MS Data
Lets you review chromatograms and spectra, perform library searches, 
and review and process quantitation results.

5
Standard MS Reports
Lets you create, edit, and view standard MS reports.

6
Custom MS Reports
Lets you create, edit, and view customized MS reports.

7
Security Administration
Lets you set MS Workstation security options and passwords.

8
Batch Reporting
Lets you generate standard reports for a group of data files by dragging 
and dropping them on the Batch Report window.

9
View/Edit Chromatograms
Lets you review standard GC chromatograms, interactively edit data 
handling parameters, and recalculate results.

10
Standard Chrom Reports
Lets you preview standard chromatogram and results reports.

11
ACSEd
Active Compounds Set Editor. Activates a set of compounds.

12
Quick Start!
Lets you run a sample without a Sample List.

13 Provides quick access to the most recent data file used.

14 Provides quick access to the most recent method used.
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2 MS Workstation Views and Toolbars

System Control View

The System Control view is displayed when you startup the MS 
Workstation. This window displays the configured instruments 
and their parameters. 

The Instrument Status Window provides an overview of the 
installed modules, active method, and automation information 
such as number of injections and calculations.   
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System Control Toolbar

The System Control Toolbar contains common actions that are 
required to run automations and edit methods.

1 2 3 4 5 6 7 8 9 10 11 14 15 1612 13

1
Creates a new automation file (RecalcList, SampleList or 
Sequence). You are prompted for the name of the new file.

2
Opens an existing automation file. Displays the Open 
Automation Dialog Box.

3 Opens the message log file.

4

Active Method QuickLink button. Lets you display 
operations that may be performed on the active method, 
including re-activation (which downloads the method to 
any modules attached to the instrument).

5 Activates a method. Displays the Active Method dialog box.

6
Displays the Edit Notes dialog box. Notes are displayed in 
the Open File dialog box and are included in the 
automation file printout.

7
Displays the Module Information Editor dialog box. Module 
information is logged in data files generated by the 
instrument and can be included in reports.

8 Displays the Instrument Status Window.

9
Displays the Inject Single Sample dialog box and lets you 
inject a single sample.
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2 MS Workstation Views and Toolbars

10
Begins the RecalcList currently open in the instrument. 
This item is disabled unless a RecalcList has been opened.

11
Begins the SampleList currently open in the instrument. 
This item is disabled unless a SampleList has been opened.

12
Begins the Sequence currently open in the instrument. This 
item is disabled unless a Sequence is open.

13
Pauses automation. The current run will complete and then 
automation is suspended.

14
Resumes automation after a pause. Automation continues 
at the point that it was suspended.

15
Stops automation. Stops the current run, resets all modules 
simultaneously and suspends the Sequence.

16

Instrument status indicator. Shows if the instrument of:

Not Ready - Running - Computing - Printing. 

When the instrument is ready but not running (idle), no 
status is displayed.
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System Control Module Windows

Each module of the instrument will have a separate window 
visible in System Control. Below is a brief description of the 
7890A/7693 Module Window, the 220 GC/MS Ion Trap Module 
Window, and the 240 GC/MS Ion Trap Module Window.

7890 Module Window

If a 7890A GC is configured, the following window will be 
displayed in System Control. 

This module window displays the GC status (left column) and 
ALS status and configuration (top). 
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2 MS Workstation Views and Toolbars

The 7890 GC Operation section (top left) displays the method 
runtime, end time, ready and fault status. From this section you 
may: 

• Start the GC only (Start button)

• Reset the GC module (Reset button)

• Edit the GC section of the active method (Method button)

• View GLP information (GLP button) 

220 GC/MS Ion Trap Module Window

The 220 GC/MS Ion Trap Module Window displays the general 
status of the instrument. From here you may access the Auto 
Tune, Temperatures, Diagnostics, Shutdown and Acquisition 
functions. 
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240 GC/MS Ion Trap Module Window

The 240 GC/MS Ion Trap Module Window displays the general 
status of the instrument. From here you may edit the online 
method or access the Auto Tune, Temperatures, Diagnostics, 
Shutdown and Acquisition functions. 
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2 MS Workstation Views and Toolbars

MS Data Review Toolbars

The following section describes the MSDR Toolbar icons. Refer 
to the online help for more details. 

Main Toolbar on page 25

Chromatogram Toolbar on page 27

Spectrum Toolbar on page 29
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Main Toolbar

.

5 12

1 Selects data file to plot and allows you to select a mass or range of masses.

2
Print opens the Make Reports Window for various printing options for 
chromatograms, spectra, etc.

3
Export opens a menu for exporting chromatograms, spectra and various views 
to relevant applications such as ASCII, the clipboard and spectra to spectra 
lists.

4 Opens the Plot Chromatogram and Spectra view.

5 Displays TurboDDS in the Plots view (500-MS only).

6

Search offers a choice of:

• Library searching the active spectrum

• Target list searching the active spectrum

• Target list searching the active chromatogram

7 Opens the Process Data view.

8 Opens the Results view. 

1 2 3 4 6 7 8 10 11 139
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2 MS Workstation Views and Toolbars

9
Opens the NIST MS Search application and initiates a NIST library search of 
the active spectrum.

10 Opens the AMDIS application for the active chromatogram.

11
Toggles the chromatograms and spectra pane at the right of the Plots view to 
full screen. Clicking this icon again restores the original view.

12 Rotates plots and spectra (from side-by-side to top and bottom).

13 Opens the Help menu.
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Chromatogram Toolbar

.

1 2 3 4 6 7 8 10 11 129

1 Hides the toolbar.

2 Expands the chromatogram to full scale on the X and Y axes.

3 Returns to previous scaling of chromatogram.

4
Moves the marker backwards, scan by scan, to display spectrum 
at each point.

5
Moves the marker forwards, scan by scan, to display spectrum at 
each point.

6
Opens the menu to set the single click action of the mouse in the 
chromatogram window.

7
Opens the menu to set the click and drag action of the mouse in 
the chromatogram window. 

5 13
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2 MS Workstation Views and Toolbars

8

Toggles between the following views when clicking a peak: 

• Spectrum of the peak at the point of the mouse click 

• Spectrum at the apex of the peak 

9
Shows the spectrum of the point of selection on a peak or an 
average spectrum. May represent up to 7 scans (point of selection 
plus up to three scans on either side of the selection).

10
Opens the menu for plots to be stacked, overlaid, or overlaid with 
all peaks normalized to the tallest peak in each plot.

11

Edit background correction: opens a menu so that the baseline 
can be isolated from the peaks according to the user's 
preferences, thus subtracting baseline components from the 
spectrum of the analyte.

12
Background correction markers: displays or hides the markers 
separating the baseline from the peaks.

13

Non-DDS Mode: The Base Peak (BP) icon only works for the TIC 
plot. Click the Base Peak icon to display the Intensity of the Base 
Peak. If extracted ions or other scan descriptors are displayed 
when the Base Peak icon is pressed, no change is made to these 
plots.

DDS Mode: Click the Base Peak icon to change the All Scan 
Descriptors RIC plot to Intensity of Base Peak or vice versa. If the 
survey scan or any other MS levels are also displayed, the survey 
scan is also displayed with the All Scan Descriptors (RIC or 
Intensity of Base Peak) Plot in the same mode.
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Spectrum Toolbar

.

1 2 3 4 5 6 7 8 9 10 11

1 Hides the toolbar.

2 Expands the spectrum to full scale on the X and Y axes.

3 Returns to previous scaling of spectrum.

4
Opens the menu to set single click action of the mouse in the spectrum 
window; see Chromatogram toolbar

5
Opens the menu to set the click and drag action of the mouse in the 
spectrum window; see Chromatogram toolbar. 

6
Sets the Mass Ruler Point selection mode to the 
Nearest m/z or Highest m/z.

7
Sets the Y axis of the spectrum as auto scaled so that base ion is either 
full scale or fixed to your preference (with the fixed selection, the Y axis 
must be less than full scale for the base ion).

8

Set mass range: spectrum will show the acquisition range or a fixed range 
that you have selected. If maximum of current and previous is selected, 
the acquisition range will be displayed but will no longer be normalized 
to the base peak 
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2 MS Workstation Views and Toolbars

9

Set spectrum display: provides you a choice of a plot of mass of ions 
versus intensity, a table of ions and intensity as percent of the base peak, 
or a summary of information about the spectrum (data file name, run 
time, acquisition range, etc.).

10
Background correct spectrum: may be set to on or off. On means that 
extraneous ions from the baseline have been removed from the analyte 
spectrum display.

11

Open menu to enter a single ion or range of ions. A range of ions can also 
be entered by selecting a portion of the spectrum with the mouse. After 
the ions are entered, click the Plot button, to generate a chromatogram 
that only contains the ions selected.
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3 Common Tasks

Before Running Samples on the Agilent 220 GC/MS Ion Trap

Before running samples on the Agilent 220 GC/MS Ion Trap, 
access the Ion Trap Module Window and perform the steps 
listed below.

1 Check temperatures. 

a Click the Temperatures tab. 

b Confirm the trap, manifold and MS transfer-line are set at 
temperature to run samples. (The GC Heater Interface 
[GCHI] will automatically be set to the same value.)

c Remember, at least 2 hours are required for thermal 
equilibrium for trap electrodes. Tuning the system and 
running samples can only occur after this period.
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2 Manually tune the instrument.

a Click the Manual Control tab.

b Select Adjustments>RF Adjustments. 

c Turn the screw at the bottom front panel of the 
instrument to tune it, and click Save Results. 

d Click Adjust Cal Gas, and adjust the valve until the 
concentration is OK, then click Save Results.

3 Check the system status and faults.

a Click the Diagnostics tab.

b Run diagnostics to check the system for status and faults.

c Confirm all passed, or take corrective action on failures.

4 Auto Tune the instrument.

a Click Auto Tune.

b Select All and tune the instrument, including check 
air/water, the multiplier setting, mass calibration, and 
trap function calibration. 

c Check that the auto tune passes or acquisition of samples 
will not be permitted.

After completing the above steps, the system is ready to run 
samples.
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3 Common Tasks

Before Running Samples on the Agilent 240 GC/MS Ion Trap

Before running samples on the Agilent 240 GC/MS Ion Trap, 
access the Ion Trap Module Window and perform the steps 
listed below.

1 Check temperatures.

a Click the Temperatures tab.

b Confirm the trap, source (external mode only), manifold 
and MS transfer line are set at temperature to run 
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samples. (The GC Heater Interface [GCHI] will 
automatically be set to the same value.)

c Remember, at least 2 hours are required for thermal 
equilibrium for trap electrodes. Tuning the system and 
running samples can only occur after this period.

2 Manually tune the instrument and check Cal Gas.

a Click the Manual Control tab.

b Click the Checks and Adjustments tab.

c Perform the RF Ramp Adjustment.

d Manually tune the instrument by turning the screw at the 
bottom front panel and click Done to save the results.

e Perform the Air/Water Check and confirm acceptable levels, 
then click Save Results. 

f Perform the Cal Gas Adjustment, and adjust the valve until 
the concentration is OK, then click Done to save the results.

3 Check the system status and faults.

a Click the Diagnostics tab. 

b Run diagnostics to check the system for status and faults.

c Confirm all pass or take corrective action on failures.

4 Auto Tune the instrument.

a Click the Auto Tune tab.

b Select All and tune the instrument. 

c Check that the auto tune passes or acquisition of samples 
will not be permitted.

After completing the above steps, the system is ready to run 
samples.

G1431-90002.book  Page 35  Thursday, May 12, 2011  1:20 PM



36 MS Workstation Getting Started

3 Common Tasks

GC/MS System Shutdown

1 From the AgilentWS/Service folder, activate the GC 
Shutdown method. This will set GC zones to a low 
temperature before maintenance work is done. 

2 Click the Shutdown tab, then click the Shutdown button to 
shutdown the vacuum system and heated zones in an orderly 
manner. When the Shutdown button is pressed in the 220-MS, 
and 240-MS, the GCHI is set to 35 °C by default.

3 Wait until all zones are cool before turning off power.

4 Open the vent and wait 10 minutes before starting 
maintenance. 

5 Confirm the GC heated zones are cool and turn off power 
before starting maintenance.

GC/MS System Startup

1 Confirm the vent is closed and all GC and MS connections 
are tight. Power-up the MS and the GC.

2 Open System Control from the MS Workstation toolbar to 
activate communication between the PC and all modules 
connected to it. 

3 Check the Status screen displays of the GC and MS. The 
Startup/Shutdown tab will appear as the turbo vacuum pump 
spins-up. The turbo pump speed should reach 100 + 1 % in 1 
to 2 minutes. The turbo current should be less than 350 mA 
when the turbo reaches 100 %.

4 Click the Diagnostic tab. Check vacuum levels of foreline 
pressure (<100 mTorr) and ion gauge pressure (< 200 µTorr 
after a few minutes). 

CAUTION Exposing the trap electrodes to air above 100 °C may damage them.

G1431-90002.book  Page 36  Thursday, May 12, 2011  1:20 PM



Common Tasks 3

MS Workstation Getting Started 37

5 Click the Manual Control tab. Turn on the trap and check the 
system for high mass noise.

6 Click the Temperature tab. The system must be baked-out to 
remove excess water and background for proper tuning and 
before running samples. 

7 Click Start Bake-out. 

8 After an overnight bake-out, perform the common tasks 
described above before running samples on the MS. 
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3 Common Tasks

To Acquire Data in System Control

1 Click Instrument>Setup Ethernet Communications and ensure 
that the GC is configured in System Control.

2 If the ALS is connected to the GC, click 
Instrument>Configuration and place the GC module in the 
AutoStart box, if it is not already there. 

To inject a single sample

1 From the System Control Toolbar, click the Inject Single 

Sample icon  to display the Inject Single Sample 
dialog box, shown below.

2 Enter Sample and Vial information. 
In this dialog box, you may change the injection method, 
where and how data files are saved (Data Files button) and 
options for the RecalcList (RecalcList button).

3 If pretreatment is required, click Sample Prep Program (shown 
above as none), and a new dialog will appear. Enter the 
program steps into the displayed dialog box and save. 

4 After setting all parameters, click Inject to run the sample.
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To create a sample list

1 From the MS Workstation Toolbar, click Edit Automation Files.

2 Click File>New>SampleList. Select the appropriate Sample 
List Type. Enter sample and vial information. 

3 If pretreatment is required, click on the Sample Prep Program 
(shown above as none), and a new dialog box will appear. 
Enter the program steps into this dialog box and save. 

4 Click Data Files to place the files in the correct folder. 

5 Click RecalcList to create a RecalcList.

6 Save the SampleList. The sample list is now configured to 
make injections and collect data.

To run a sample list

1 From System Control, select File>Open Sample List, and select 
the appropriate sample list to run. 

2 From System Control, click  to open the Sample List 
dialog box. 

3 In the Sample List dialog box, select Begin to start the 
automation. 

To edit an entire method

1 Before performing any type of off-line method editing, make 
sure that the GC has been configured in System Control.   
This will enable the GC configuration to be properly stored 
for use in the Method Editor. 

2 From the System Control Toolbar, click the Method icon 

 to open the Method Editor. The 
Method Editor can also be accessed from the Method Editor 
icon on the MS Workstation Toolbar. 

3 Modify the sections of the method as needed. The Method 
Editor allows you to set-up instrument parameters and 
post-run processing for all configured modules. 
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4 Save any changes made to the method. 
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To Analyze MS Data

MS Data analysis is performed in the MS Data Review (MSDR) 
Application. 

1 From the MS Workstation Main Toolbar, click  to 
access the MS Data Review application. 

2 From the MS Data Review toolbar, click  to open a data 
file.

3 With the data file open, click  to access the Process 
View. 

4 Click Process to perform the calculation. 

5 Once the file has been processed, click the Results View icon, 

 .

6 In the Results View you may view the Calibration Curve, 
Results List, and Reports. 
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3 Common Tasks

Operating Tips

• Back up your data and methods regularly.

• Save Tune reports in a notebook for future reference.

• Perform system maintenance as indicated by the 
maintenance schedule at the end of this manual, or in the GC 
and Ion Trap hardware documentation. Keep a record of all 
maintenance performed.

• When venting the Ion Trap, take advantage of the cool GC to 
do maintenance such as replacing inlet liners, septa, etc.

• After bake-out, wait at least 2 hours for the Ion Trap to reach 
thermal equilibrium before tuning or acquiring data.

• Optimum sensitivity generally occurs at column flow rates of 
1.2 mL/min or less.

• When injecting volumes greater than one microliter, use the 
pulsed splitless mode and increase the initial oven 
temperature 10–20°C.

• For splitless injections, pulsed splitless mode gives more 
quantitative sample transfer onto the column. A pulse 
pressure of twice the initial inlet pressure is typical.

• Selecting Constant Flow mode will provide the most efficient 
separation in most cases.

• For a new column, check that the column nuts are still tight 
after the first few oven temperature cycles.

• Use the [Config] [Status] buttons on the Agilent 7890 
GC keypads to set the three display items most important to 
you (for example, time remaining, oven temp, etc.). 

• Rinse and refill ALS wash vials. Do not add more solvent to a 
partially full vial.
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4 Basic Troubleshooting

Basic Troubleshooting

Run Diagnostics when hardware failures occur. Refer to the 
hardware manual for detailed procedures.

Ion gauge pressure is > 200 µTorr

• Check GC helium flow; it should be 1 mL/min (no pressure 
pulse).

• Check for tight column nuts on the injector and transfer line.

• If the analyzer has been removed, check the O-ring seal for 
particulates or fibers.

• Check the O-ring on the transfer line for twists, deformation, 
or tears. Replace the O-ring if necessary.

Leak checking

To determine if the leak is in the MS or the GC:

1 Go to System Control, activate the Daily Checks method 
(DailyChecks.mth), and view the mass range of 10-50 m/z in 
the Manual Control Mode of the MS module window. 

2 Increase the carrier gas flow from 1 mL/min to 2 mL/min. 

- If the 28 ion increases or decreases, then the leak is 
probably in the GC or line gas filters. 

- If the 28 ion abundance remains stable, the leak is 
probably in the MS. 

If the leak is in the GC or line gas filters:

Perform injector maintenance and recheck using the Daily 
Checks method. If the leak persists, check for leaks at the GC.
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If the leak is in the MS:

1 Check that the column nut is tight. 

- If the column nut is secure, set the scan range from 10 to 
100 amu and use a Freon-based dusting canister to spray 
around the various seals: column nut, transfer line O-ring, 
and analyzer O-ring. 

- If these sprays are not available, use the argon gas supply. 
Systematically spray the argon in short bursts at the seals 
and look for an ion at 40 amu. 

2 If the location of the leak is still unknown, plug the MS at the 
transfer line and repeat the leak check on the MS. 

- If the plugged MS does not leak, connect the GC and leak 
check the GC.

No FC43 (Cal Gas) signal

Run the Diagnostics to check for an electrical problem. Loss of 
signal may be caused by:

• Burned out filaments

• No Cal Gas in vial

• Large air leak

Loss of signal on sample runs

The most common MS reasons for loss of signal are:

• Dirty trap electrodes (clean electrodes)

• Dirty gate conductor and trap gate conductor (clean or 
replace conductors)

• Carbon deposits at trap oven near filaments

• Cracked quartz spacers (replace)

The most common GC reasons for loss of signal are:

• Plugged syringe needle

• Dry or loose plunger
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• Poor injection method

• Labile or active compounds

• Poor analytical conditions
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Routine Maintenance

Maintenance depends upon sample load, matrix, and quality 
control requirements. Your applications may require different 
maintenance intervals than the following. For more 
information, refer to the appropriate manual.

Daily

• Check and, if necessary, refill the solvent wash vial on 
autosampler.

• Check the autosampler syringe and stroke count. Replace as 
needed.

• Check for leaks by running the air/water Segment #1 of the 
DailyChecks.mth.

• Check gas filters and the carrier gas supply (>250 psi on high 
pressure stage of regulator).

• Check the tightness of the column nut on the transfer line 
and injector.

Weekly

• Adjust the Cal Gas and run all Auto Tune functions.

• Use the Daily Checks.mth to check High Mass Noise.

• Bake out the ion trap overnight or over the weekend.

Monthly

• Run diagnostics for the multiplier, RF, and filaments.

• Check the RF voltage range and adjust if non-linear.

2 to 3 Months

• Replace the column, if necessary.

• 210/220-MS Check the color of the oil in the foreline pump. If 
it is dark or muddy, change the oil and the oil mist cartridge 
more frequently.
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• Clean trap electrodes if needed.

• Replace the filament if it is broken, fails diagnostics, or 
shows low sensitivity.

Yearly

Change the foreline pump oil and the oil exhaust filter.

Variable

• Refill the calibration gas bulb when empty.

• Check and replace the injector septum (50-200 injections or 
as needed).

• Clip the column (8-30 cm, frequency is dependent upon 
matrix).

• Run the Mass Calibration and Trap Function Calibration if 
masses are not assigned correctly.

• Replace the electron multiplier when voltage exceeds 2500V.

• Check that the GC/MS gas filters are clean. Replace them 
when necessary.
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